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Disclaimer 
 

DCNC, Inc. makes an effort to ensure the accuracy and quality of these materials; however, they 
make no warranty whatsoever, express or implied, with respect to the correctness, reliability, or 
appropriateness of the material for any particular purpose. All the data and examples contained 
herein are intended as fictional only. Any resemblance to real persons or clients is coincidental. 
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Saving and Profiling in Worldox  
 

Chapter at a Glance 
Profile Groups 
Saving a New File 
Type Down Feature 
Favorites Tab for Profile Field Table Windows 
Subsequent Saves treated as a Save As  
Quick Profile 
Make a Quick Profile the Default Profile Group 
 

 

Profile Groups 
You have several profiles to select from depending on what type of file you are saving.  The 
following profile groups are available: Files, HR, and Private.  

Saving a New File 
After you have created a new file, save the document by clicking Save. The Worldox save screen 
will now open to your default profile. Enter all of the required profile fields, including the 
description, and click OK. The document will now be saved in Worldox and assigned a unique 
Document ID number.  

 
 



 5 

• Fill in the Description field with what you would like to name the document. This field 
can be up to 120 characters long.  

• Use the Comments field to further describe the file. Enter keywords that could help you 
search for the document in the future. This field will hold up to 5,000 words and is text 
searchable with the Description of the document.  

Type Down Feature 
When saving a document, click the name of the field (for instance, Client) to see the table with 
all options available. To quickly search the table for the Client you’re looking for, simply start 
typing the name or client number. You do not have to highlight the field you are attempting to 
search in. This feature will work for the other lists as well (Matter, Doc Type, Author, Doc 
Date). 

 

 

 

 
 
Favorites Tab for Profile Field Table Windows 
There are two tabs located on the profile field table windows. One is for the default profile fields 
and the other is the Favorites tab. The Favorites tab will track and display your recent choices for 
that selected field. This can make it easier to find the choices you make often. 

For example, when you click on the Client button you are presented with the Client profile field 
table as shown in the figure to the left. 

 

 

 

 

 

Click on that Favorites tab and you will see all of the recent choices you have made for this field, 
shown in the figure to the right. Any choice you recently made will appear automatically on this 
Favorites tab. This Favorites tab appears for all of the other Profile field selection windows (such 
as Matter, Doc Type, Author, and Doc Date).  
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By right clicking on the Favorites tab, you can make your Favorites your default tab so when you 
access the table the next time, it will automatically display your favorites. You can add to your 
favorites by right clicking a client in the main tab and choosing Add to Favorites. 

Save As 
  

 

 

 

 

 

 

 

 

 

When you select Save As, you will have the following choices for saving the document: 

• Selecting Replace File automatically overwrites the file you have open.  
 
• When you want to save another draft of a file, select Save as Version. This will keep the 

same profile information but will change the version number.  
 

• Choose Save as New File to create a copy of the file while preserving the original. This 
will assign the copy a new Doc ID, and allow you to change the profile information if 
necessary.  

 
• Choose Edit Profile to modify the profile features of your current document. 

 
 

Quick Profile 
If you are going to be saving many documents with the same profile features, you can create a 
Quick Profile to save time. This will allow you to save the profile features you want to use and 
quickly apply them when saving new documents.  

The Quick Profile Menu is located in the File Save screen along the top and slightly to the left.  
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Creating a Quick Profile:  

1. Choose to save your document, and fill out all the required fields in the profile window. 
2. Click Quick Profile Menu. 
3. Choose Save As Quick Profile. 
4. Name your Quick Profile and click OK. 

 
Using a Quick Profile: 

1. Choose to save your document. 
2. Select the My Profiles tab to the right on the profile 

window. 
3. Select the profile you wish to use. 
4. Profile information will be automatically inserted. 
5. Enter a description or any desired comments. 

Make a Quick Profile Your Default 
 

1. Choose Save to open the profile window. 
2. In the My Profiles tab, right click on the Quick Profile 

you want to use.  
3. Choose Set as Default. 
4. Now all documents you save will default to that Quick 

Profile. However, you will still be able to change the 
profile information if you need to. 
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Retrieving and Searching Files 
Chapter at a Glance 

Opening a Document from Word 
Using the WorkZone 
Performing a Search 
Text Searching 
Boolean Search Operators 
Viewing a File 
Tags Filtering  
Bottom Tabs 
Quick File Retrieval 
Location Line 
Favorite Files  
Bookmarks 
Managing Bookmarks 

 
 
Searching in Worldox is an incredibly powerful, effective way to find information and locate 
documents in your firm’s Worldox document repository. You can perform quick, simple 
searches, or advanced searches that combine full-text searching, date ranges, profile fields, and 
more.  

There are several ways to search for documents in Worldox. You can open the program you 
know the document was created in (such as Word) and choose Open, or you can search by 
opening Worldox from the icon on your desktop or through the WorkZone.  

 

Opening a document from Word 
If you know your document is a Word document, open Word and choose Open. This will launch 
Worldox and you will be able to start your search. Worldox will open showing the most recent 
(or “Favorite”) 20 Word documents that you have accessed.  

Using the WorkZone 

  When Worldox is running, a small icon called the WorkZone will appear near the top 
center of your desktop. You can double click this to open Worldox, or you can drag and drop 
files into the WorkZone to automatically open the profile save window. You can also move this 
icon around your screen by clicking and dragging it to where you want it.  
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Performing a Search 
If your file is not in your Favorites, you can search multiple ways. The most powerful method of 
searching is by clicking Find (represented by binoculars) along the top of your Worldox screen. 
This will open a list of your Profile Groups. Select the Profile Group you wish to search in to 
open the search screen.   

 
 
From here, you can search by any of the profile fields that you used to save the document, as 
well as several other fields. See the list below for a description of the search fields available.  

• Name/Comment - The Name is the Description you assigned the file. Worldox searches for 
any files containing the text entered in either the Name or Comments.  

• Doc ID – Each file is assigned a unique Doc ID. If you have the Doc ID number, you can 
enter it into this field (with or without leading zeros) to immediately find that document.   

• Date Created -- The Date Created when the document was saved for the first time.  

• Date Modified -- The Date modified is when the file was last saved by its native 
application. 

• Date Accessed – The Date Accessed is the last date the file was opened. 

• Text in file -- This is where you enter words for full-text searching of your documents. 
Worldox has a fast, powerful text search engine that uses Internet-style syntax so you can 
search your own documents similarly to how you search the Web. Please refer to the 
examples in Text Searching in Worldox section in this chapter. 
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Text Searching in Worldox  
This following method of searching applies both to searches in the Name/Comments field and 
in Text in File (full-text searching). 

For basic text searching, just enter words or search terms, separated by spaces, in the Text in File 
line of the Find window. For example, breach contract. For more examples, see Sample Searches 
table on the next page. 

By default, Worldox will assume a w/3 (within three words of each other) if two words are 
entered in either the Name/Comments field or the Text in File. For a document to qualify, it must 
contain both words.  

 
• Capitalization –Worldox searches are not case sensitive. For example, the following are 

equivalent: President, PRESIDENT and pReSidEnT.  

• Punctuation – Punctuation is significant in searches. For example, searching for ASPCA will 
not find documents containing “A.S.P.C.A.” To find such a term, you must enter the periods 
between the letters: A.S.P.C.A.. 

• Automatic Exclusion of Common Words – Worldox ignores common words, such as “the” 
and “how,” as well as certain single digits and single letters. Such words tend to slow down 
your search as they are found in most documents. Alternatively, you can specify directly on 
the Text in File line to include common words by preceding them with a “+”, as described in 
the following section. A third alternative is to enclose the terms in quotation marks to search 
for the entire phrase. 

• “+” Searches – If a common word is essential to what you are searching for, you can force 
its inclusion by placing the “+” sign in front of it. In the search, his current position, 
Worldox ignores the common word “his”. This means you might get a document with “her 
position is current” or “the current position is untenable.” To include “his” in the search, and 
therefore exclude the extraneous hits, enter +his current position. 

• “AND” Searches – Worldox supports the logical AND operator. Joining terms with AND 
results in any documents that have all of the words, irrespective of how far apart each term 
occurs. For example, searching for breach AND contract returns any document that has both 
terms.  

• “OR” Searches – Worldox supports the logical OR operator. Joining terms with OR results 
in any documents that have any one or more of the words.  

• NOT Searches – Narrows your search and retrieve records that do not contain the term 
following it. For example: truck NOT pickup will find all instances where truck is present but 
will exclude any files that also include the word pickup in the file.  
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• Word Variations (Stemming) – Worldox text searching supports the use of the wildcard 
character “*” for word stemming. Use the asterisk when you want to search for variations of 
a term. You can use this anywhere in the word. 

• Phrase Searches – Search for complete, literal phrases by enclosing the words in quotation 
marks. Words enclosed in quotation marks “like this” must appear together in all results, 
exactly as entered. Phrase searches are especially useful when looking for company names, 
direct quotes and proper names. 

• Proximity Searches – Proximity searching allows you to combine search terms by specifying 
the maximum number of words you want between the terms. Worldox offers two types of 
proximity searches.  

• “W/x” Proximity Searches – Use the “W/x” operator, where x is the maximum 
number of words of separation allowed. For example, searching for elevator w/5 
lawsuit locates documents where the terms “elevator” and “lawsuit” occur within five 
words of one another. Note that the order in which the words occur is not 
significant—only their relative position (proximity) to one another matters.  

• “/x, y/” Ranged Proximity Searches – This allows for a unidirectional search, from 
left to right, within the range of words specified by x and y. For example TECH /3,9/ 
CALL would search for "CALL" within three to nine words of "TECH", where 
"CALL" must appear to the right of "TECH". Note that there can be no spaces 
between the opening and closing slashes. 
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Boolean Search Operator Examples 
If you want to narrow a search, you can add in Boolean search operators. See the table below 
which highlights Worldox’s powerful full-text searching. 

Text Search Example Description 
motion to compel Finds documents where the word “motion” and the word “compel” 

are both found. Since “to” is a common word, it is ignored.  
order cease desist Finds documents where the word “order”, “cease” and “desist” all 

occurs within a document. This is the same as: order AND cease 
AND desist. 

“order to cease and desist” Finds documents that include the exact phrase “order to cease and 
desist” only. To find an exact phrase, enclose it in quotation marks. 

1992 AND gonzalez AND 
pleading 

Finds documents with the terms “1992,” “gonzalez” and “pleading.” 
All three terms must appear. This differs from searching for 1992 
gonzalez pleading in that the terms do not have to occur within three 
words of one another. 

wor* Finds documents beginning with the letters “wor.” This would find, 
for example, documents with such words as “Worldox”, 
“worldwide”, “workshop” and “worship”. 

*duction Finds documents ending with the letters “*duction”. This would 
find, for example, documents with such words as “production”, 
“introduction”, and “reduction”. 

truck NOT pickup Finds all instances where truck is present but not pickup. 
hospital w/10 jalapeno Finds documents where the word “jalapeno” occurs within 10 words 

of “hospital.” For example, “She was taken to the hospital after 
eating a particularly hot jalapeno.” 

truck OR lorry Finds documents with either the first word, the second word or both 
words. In this example, the term “lorry” is a synonym for “truck,” so 
including it in the search, joined with OR, ensures that you’ll find 
documents using either term. 

hot /2,4/ dog Finds documents where the word “hot” occurs prior to, and between 
two and four words of “dog.” For example, “It was so hot the dog 
ran beneath the sprinkler.” Something like the following would not 
qualify: “He entered the hot dog eating contest.” 
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Viewing a File 
After you have performed a search, you will be presented with a list of files that 
have met your search criteria. If you want to preview a file in the viewer before 
opening it, select the file in the Worldox window and click the View button. Or 
you can select File>View.   

Tags – The Visual Filter  
Tags filters in Worldox is a visual way to see the distribution of profile field values and other 
elements within work lists, along with a set of graphic tools for setting work list filters. To use 
Tags, choose the Tags tab along the bottom of the Worldox screen.  

 
 
What can you do with Tags?: 

• Visual “weighting” means that types of files with that profile will appear larger and 
bolder than others. In this picture, you see that the current list has more .PDF and .MSG 
files than other file types. 

• The ability to filter by including or excluding items by checking the icon to the left of 
each category, making it either a green “plus” sign or a red “negative” sign.  
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• The ability to set multiple filters, (i.e., set all filters before re-filtering, refreshing the list) 
 

• A symbol appears to the left of each filter category:  
= Include     
= Exclude 

• Rolling the mouse cursor over any item displays a checkbox next to that item, and a 
highlighted message detailing how many times this item appears in the work list: 

 
You can set any number of filters in this window by clicking on those items checkboxes: 

 
 
 
 
 

You can click that left-side category symbol to toggle between include and exclude. Clicking the 
type category symbol above switches the filter to exclude by those elements. 

 

 

 

The  button is another useful tool. Click this to not display any items that only 
appear once on the visible work list files. This can make it much easier to use Tags filters on 
larger lists. 

Bottom Tabs 
 

• Full List fills the window with the worklist.  

• Comments displays and allows you to add, edit or delete the comments for the 
highlighted file. 

• Profile displays and allows you to edit the profile for the highlighted file. 

• Viewer displays the highlighted file in a preview window. 

• Relations displays files related to the highlighted file. 

• Project displays the projects window. 

• Tags Displays the results in a visual filter format.  
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Quick File Retrieval 
There are a number of ways to quickly access files you have recently opened, searches you have 
recently executed, and folders that you have recently accessed. 

The Location Line, and Favorite Files button are the most commonly used features to access 
files. 

The Location Line 
 
 

 
 
 
 

You can enter the Doc ID or Name/Comments of a file you want to find directly in the 
Location Line field, then press Enter or click on the Go button. 

You can also access a history of your recent searches by clicking on 
the drop down arrow to the right of the Location Line field or click 
on the Location button. From there select the search or folder that 
you have recently accessed. 

 

 
 
Favorite Files List Button 
Click on the Favorite Files List button to display the 
Worldox Work List window. From this window, double click on the 
file type (e.g., Word, WordPerfect) or Worldox Action (e.g., Moved, 
Copied) to display up to the last 20 files of that type that you have 
accessed. You can also click on the <ALL> to display last 20 of all 
the types listed. 

 

 

 

Location Back 

Location Forward 

Location List 

Search History 

Go 
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Favorite Matters 
You can view a list of the folders of your favorite files from the view buttons to the left of your 
Worklist. This is similar to the Worldox Favorite Files feature except folders are tracked instead 
of files.  
 
You can remove entire Profile Groups and also folders that appear in the Favorite Matters pane. 
 

1. Right-click the folder or group you want to remove and click Remove from Favorites.  
 

2. Once a folder or group has been removed the structure will be need to be re-accessed to 
add them back to Favorite Matters. Folders or groups will also be removed for the 
Favorite Files listing if you remove them here. 
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Bookmarks 
Bookmarks allow you to save frequently used searches for future use. You can either save the 
Bookmark on the Button Bar by pinning the Bookmark or you can uncheck the Pin to button 
bar checkbox and the bookmark will be located in the Bookmarks drop down menu. 

To Create a Bookmark: 

 

 

 

 

 

 

 

 

 

 

Managing Bookmarks 
 

• To Edit a bookmark Right Click on the Bookmark > 
Select Edit Bookmark>make changes>Click OK.  

 
 
 
 

• To Delete a Bookmark Right Click on the Bookmark> 
Select Delete Bookmark>Click OK. 

 
 
 
 

• To Email a Bookmark to another user Right Click on the 
Bookmark>Select Email to another user>Fill out the  
Email and send as usual. 
 
 

1) Do the search you wish to bookmark 
2) Click Bookmarks in the title bar 
3) Select Add this list 

 
 
 
 
 

4) Name the Bookmark 
5) Decide where you want it to show 

On the Button Bar or in the drop down menu. 
6) Click Save 
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• You can also edit Bookmarks by selecting Manage from the Bookmarks menu. In Manage 

screen, use the functions along the top of the screen to Add, Edit, or Delete Bookmarks.  
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Email Management 
Chapter at a Glance 

Attaching a File to Email from the Worldox WorkList 
Attaching a File to an Email using Outlook 
Profiling Sent Emails 
Profiling an Email from Outlook 
Profiling Email Attachments from Outlook 
Saving an Incoming Email Attachment as a Version  
Saving with Same Profile As 
Quick Email Profiling 
Managing your Quick Profile Folders 
 

 
You can email files directly from the Worldox screen without having to go into your email 
application. However, you can still email attachments from within your email application by 
selecting Insert>File in the New Mail Message Form window. 

You can create, view, forward, and reply to email directly from Worldox. Outlook users can 
profile email messages and attachments directly from Outlook into Worldox. 

You can view your Inbox directly from Worldox. You can send email, and also profile email 
messages and attachments. 
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Attaching a file to Email from the WorkList 
Using the WorkList, you can select from three different methods to insert a file into an email 
message. 

Sending to someone in your firm: 

The Worldox file list feature can 
only be used internally. When the 
recipient clicks on the link in the 
Email, it will take them to the 
Worldox File Open screen with 
the file highlighted. 

Sending to someone outside your firm: 

Use the Full Copy feature for external emails. This sends a copy of the entire file. To 
open the attachment, users outside of the office will open attachments as they normally 
do. Worldox will automatically apply the standard file extension for the file type. This 
method will send the most recent version of a multi version file. 

Use Compressed to zip large files sent to external users. You also have the option of 
adding a password.  

 
 

 
Attaching a file to an Email using Outlook 
Address your Outlook email as usual. When clicking on the Insert file button or the File option 
on the Insert menu, a Worldox window will display. Find and double-click on the file you wish 
to attach. If the file has versions, you will be presented with a Worldox Open window asking if 
you want to open the most recent version or display a list of all of the versions. You will then be 
presented with the same three choices as shown above.  
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Profiling Sent Emails (This automatic pop-up has been 
disabled) 
When sending Email from Outlook you will have a Worldox Sent Message window 
automatically pop-up after clicking on the Send command in Outlook. This message is disabled 
for all Internal Recipients. The Worldox administrator can also disable this message for specific 
domains and individual email addresses. You can also control this on the individual 
workstations. If you have previously profiled an email from the recipient and you decide to copy 
or move the sent message to Worldox, the Smart Profile feature will provide a pre-populated 
profile. You can at that time change any of the fields. If you have never profiled an email for the 
recipient you will need to fill in all required profile fields. If you don’t want to be prompted to 
profile an email to a specific address you can click on Add this address to my ignore list. If you 
don’t want to profile the email just this time click the Ignore button and the next time you send 
an email to that address it will still ask you to profile it into Worldox. 

 

 

 

 

 

 

 
Profiling an Email from Outlook 
To copy or move an email from your inbox into Worldox:   

1) Highlight the message you wish to copy/move.   
2) Click on the Worldox Tab. Click on the Copy or Move to 

Worldox – this will bring up your profile window.  
3) Fill out the profile window as normal.  

Messages profiled by this method are saved in a standard message format (.msg) recognized by 
most email client programs. You will be prompted to complete the profile information. 
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Profiling Email Attachments from Outlook 
Attachments to an email message are included when the original message is profiled to Worldox 
using any method. The attachments are saved along with the original message, and they can be 
viewed later when the message is opened. 

Attachments saved as part of a message are text searchable through Worldox. Attachments can 
also be saved separately from the email that they were attached to so that you can find them 
independently of the email. Or sometimes the email is not important and you only want the 
attachment in Worldox. To do this you right click on the attachment then click Save As and the 
profile window will open for you to profile the document. 

If you save the attachments as a separate document after you have copied or moved them to 
Worldox, the attachments are automatically related to the original email. 
 

Saving an Incoming Email Attachment as a 
Version 
We often send files to external email recipients for their revisions. When they email the file back 
to us it can be desirable to save the file as a different version of the original file. As long as the 
recipient does not change the file name you can easily create a different version of the file by 
dragging the file to the WorkZone, or by right clicking attachment and clicking save as. 
Worldox recognizes the document ID and will allow you to replace the original file, save as a 
different version, save as a new file or edit the profile.  
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This would be the scenario in a perfect world! However, most of the time, the recipient changes 
the name of the document and when we receive it, saving it as a new version becomes a bigger 
challenge. In this situation use the same profile as feature shown in the next section. 

Using Same Profile As 
When you receive a file attachment that needs to be a new version of an existing document but 
the sender has changed the name of the document, Worldox does not automatically recognize it 
as an existing internal document.  
 
The Same profile as option is the easiest and best method to use.  

1. In Outlook, right-click on the attached file 
and select Save As. The Worldox Save 
Attachment window will be displayed. 

2. Click on the Same profile as… button 
3. Search for and display the original document 

(or a document you wish to attach a new 
version). 

4. Double-click to select the document. The 
following screen will be displayed.  

5. Select Save as new version of this file. The 
file is now the next version of the original 
document. 

 
 

 

You do not have the opportunity during this process to change the file name or add additional 
comments. However, you can easily find the document version in your Worldox window and 
modify any of the profile fields as desired. 
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Quick Email Profiling 
Create Quick Profiles as Worldox Folders in the Outlook tree 
Worldox has folder based drag and drop email profiling for Microsoft Outlook users. To create a 
Worldox folder within the Outlook folder list (Quick Profile), select an email message and 
select Move to Worldox button. After filling out the profile fields, Worldox will give you the 
opportunity to create a Quick Profile folder in Outlook. Select Yes when prompted and confirm 
the information for the fields and then name the Quick Profile (Folder) and select OK. 

  

 

 

 

 

 

 

You will have a sub folder under Worldox in your Outlook folder list. If you want to create 
subfolders below that simply use a backslash \  after the folder name as shown below. 

 

 

 

 

 

 

Once you have your Quick Profiles created, you can drag and drop one or more email messages 
from your inbox to the Worldox folder and Worldox fully profiles the messages and moves them 
to Worldox. We recommend that you profile no more than 75 emails in one save. 
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If you want to stay in Outlook and work with Worldox you don’t need to toggle between the two 
applications.  Outlook is instructed to provide drop folders to display Worldox within Outlook, so 
that it displays in the right-side frame of the Outlook window. The result is a seamless interface – 
two applications displayed in one application window. 

 

 
 
 
 
Even though you are working with Worldox GX3 in that right-side frame, you are still in 
Outlook. Just click back on any message category in the left-side path tree, and you are once 
again looking at Outlook content.  
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Manually Profile Folder 
Under the Worldox GX2 folder in the Outlook tree, you will notice a folder called <Manually 
Profile>. This folder catches e-mails that were part of a failed attempt to profile into Worldox.  
In the event of a cancelled or failed email profiling attempt the following message will be 
displayed.  

When you see this message please click on the <Manually Profile> folder to find and complete 
the processing of the e-mail. 
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Managing your Quick Profile Folders 
Create Worldox folders without having to move an email. 
 

 

1) Select the Worldox folder 
in your Outlook tree. 

2) Select Quick Profiles 
button in the message 
window.  

3) Select My Profiles button. 
4) Select the New Button. 
5) Fill out the required fields. 
6) Name the Quick 

Profile>Click OK 
 

You will go to this location to 
delete old quick profile drag and 
drop folders.  
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Working with Existing Files 
Chapter at a Glance 

Quick Menu 
 

 
The Worldox Main window and the Worldox Word File Open window are where many of our 
everyday tasks will be performed. Copying, moving, previewing, searching, and emailing files 
are examples of some of the tasks we may need to perform. 

 

 

This main window will often be our "headquarters" and we will want to customize this window 
to meet our specific needs. In this chapter we will examine the basic features of the 
Worldox main window, and in the next chapter we will learn how to customize the window. 
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Quick Menu 
Many functions can be performed by selecting the file and accessing the Quick Menu. Open the 
Quick Menu by right clicking on any document in the Work List in Worldox.  
 
 
 
 
 
  
  
        
 
 
 
 
Cancel This closes the Quick Menu  
Send To This opens up the Secondary 

Menu 
 

 Local Mirror This option copies the file to the local mirror on 
your hard drive. (available off-line) 

 F:\ If you have a thumb drive inserted into your 
computer it will show up with the Windows 
assigned drive letter here. 

 Copy to Windows Desktop This option copies the file or files to the user’s 
Desktop 

 Copy to Windows My 
Documents 

This option copies the file or files to the user’s 
My documents folder 

 Copy to Windows My Pictures This option copies the file or files to the user’s 
My pictures folder 

 DVD/CD Rom Drive This option copies the file or files to the folder 
within Windows that allows you to write them to 
a DVD/CD. 

 Printer This option opens a window for you to select the 
printer and print the file or files. 

 Printer (Default) This option prints the file or files to your default 
printer. 

Edit This opens up a sub-menu with 
options for copying the selected 
files path to the Clipboard. 

 

Favorite 
Files 

This opens up options to add or 
remove the file or files from 
selected favorite files. 
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More This opens up a secondary Menu 
– This is dynamic – as you use 
these features they will show in 
the main Quick Menu. 

 

 Open With This opens a window that allows you to open the 
file with a different application. 

 View File This opens the file in the Worldox Viewer. 
 List Versions This opens a new tab with a list of versions 
 Make New Version This saves the document as the next version. 
 Check–Out This checks the file out to be worked on off-line. 
 Check-In This checks files back into Worldox. 
 Copy This allows you to copy the selected file or files 

to another profile group. 
 Move This allows you to move the selected file or files 

to another profile group. 
 Delete This opens up a window and allows you to move 

the selected file to the salvage bin. 
 Security You will only see this if you have rights to add 

security to a document 
 Email      This attaches the highlighted file or files to a blank 

email. 
 Open File Location This opens the file location on the server. 
 Edit This allows you to edit the profile of the file or 

files selected, set the owner of the file or files and 
also assign to categories. 

 Audit This shows you who created the file and everyone 
who has modified, copied or moved this file. 
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The Worldox Environment 
Chapter at a Glance 

The Worldox Window 
Customizing the Window 
Change Sort 
Date Grouping 
Window Style Features 
 

 

Your Worldox Window 
Your Worldox window will look something like the following window: 
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Click here to add Column Headings 

To Rearrange the 
Columns, select the 
Column Heading you 
want to move and drag 
and drop it to a new 
location on the Column 
Header 

  

To Delete a Column, 
select the Column 
Heading you want delete 
and drag it off of the 
Column Header 

  

To Size a Column, move 
your insertion point over 
the Column Heading 
until it takes the shape of 
a bracket, [ or ], then 
drag to resize it.  

To Sort Columns, right-
click on the Column 
Heading and select 
Change Sort.  

Customizing the Window 
Worldox windows can be customized for each Open window in every application that you use. 
Column headers can be added, removed or moved to different locations and they can be sorted as 
well. Once you have customized your window you can save the style so it will look the same 
each time you access it. 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Select the field or fields 
you want to appear as a 
Column Heading 

 This is the Best Fit button. By 
clicking this button it will modify 
the columns for the best fit. 

If you want to add a field from a specific Profile Group, 
make sure that you have displayed a search result based on 
that Profile. If you are displaying Favorites you will not see 
any Profile Group Fields and will display None. 
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Change Sort 
You can easily change the sort of a column heading by clicking on the column heading. The first 
time you click on the heading it will change to Ascending sort and the second time you click on 
the heading it will change to a Descending sort. The little blue arrow    shows which column is 
being used for the sort and which direction it is sorting.  

Date Grouping 

 

If you have chosen to sort by Modified Date Column Heading, Worldox will automatically 
group the files based on date ranges as shown above. To disable this grouping feature you will 
need to right-click on the date column heading and choose Hide Groupings.  

Worldox Window Styles Feature 
Worldox Window Styles is a feature that allows you to save several window layout elements for 
a variety of Worldox list types. Once you have selected the column headings you want, sort the 
column headings the way you want and select the appropriate document tab you will want to 
save your Window Style. 

 
 
 
 
 
 

 

 

 

 

 

Click here to 
save your 
Window Style 
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Configurable Toolbar 
Named Toolbar Buttons 

The toolbar has labels for quicker learning and instant recognition.  

 
User Configurable Toolbar 
You can add, remove or rearrange the buttons on the toolbar. You can even change the icons or 
rename the buttons. 

To Configure the Toolbar: 

To add a button:    

1) Right click the area to the far right on the toolbar. 

2) Select Append 

3) Select group button is in that you want to 
add 

4) Select button you want to add. Change 
name if desired. Click OK and the button 
will appear at the end of the toolbar. 

 

 

 

 

 

 

To rearrange buttons: 

1) Right click on button you want to move. 

2) Select Move Button Left or Right 



 

 35 

 To delete a button: 

1) Right click button you want to delete. 

2) Select Remove Button. 

To change the Text: 

1) Right click button you want to modify. 

2) Select Change Text. 

3) Change Text to what you want and Click OK. 

To change the Icon: 

1) Right click button you 
want to modify. 

2) Select Change Icon. 

3) Select Icon you want to 
use and Click Open. 

 

 

 

 

 

Now you have your new icons! 

 

 

You can also remove the separator or restore to your defaults from the right click menu. 
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View Buttons 
The buttons to the left of your work list are configurable.  

When you click on the button it opens up that list at the top.  

Favorite Matters displays a list of matters that you have 
accessed. This is similar to the Worldox Favorite Files feature 
except folders are tracked instead of files. 
 
Profile Groups and My Computer Show profile groups and 
your mapped drives. 
 
Workspaces displays files and folders that currently appear in 
your Workspace. 
 
Bookmarks displays a list of your personal bookmarks. 
 
 
 
 
 
To configure the navigation pane: 
 
The wrench icon (lower right in the navigation 
pane.) allows you to customize the icons that 
appear or reorder them in the order you would 
prefer.  

1) Select or deselect the check box next to the 
Tabs you want to appear or remove. 

2) Click the up and down green arrow buttons 
to change the order of the Tabs. 

3) Click Restore Defaults to restore the 
buttons to the default order.  

4) Select the When mouse is over panel, 
extend to fit check box if you want the 
Folder Tree to automatically resize when 
your mouse is placed over the Folder Tree.  

5) Click OK when you have made all your 
desired selections.  

 

 

Comment [LP1]:  
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Related Documents 
To relate one file to several to find them all quickly you can select a “parent” file and relate all 
the “children” files to it. Search for and display the documents you wish to relate to each other. 
Then simply select the files and drag to the relations box. Whichever file is highlighted when 
you drag and drop is considered the “parent”. You can add to these related files or unrelated 
them at any time. Now whenever you are viewing a file in the worklist you can select the 
relations tab at the bottom or Select List from the top menu then Relations and it will show you 

all related 
documents.  
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Projects 
Projects group files together for quick retrieval without moving or copying them. This works 
great if you have diverse files – That are found by multiple searches. 
  
To create a Project: 

1) Find files you wish to save in the Project. 
2) Click on the Project tab to open it. 
3) Drag and Drop the files into the Project window. 
4) Perform additional searches to find documents to add to your Project. 
5) Drag and Drop these additional files to the Project window. 
6) When all documents have been added to your Project – Click Save As. 
7) Fill out the profile. Use Project as the Doc Type. 
8) Click OK and your Project folder is complete. Close the project in the project tab. 
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You can add and remove files at any time. Find the Project, highlight (click once) it then click 
the Project tab. From the right side of the projects tab click edit. Perform a search to find the files 
you want to add then drag them to the project tab. Select Save As to save the changes to the 
Project. Close the project in the project tab. 
 
To quickly find your newly created projects click on the favorites tab on the toolbar and select 
Projects.  
 
 
 
 
 
 
 
 
 
Alternatively you can find all your projects by searching for the Doc Type of Project. 
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Workspaces - Projects 
Workspaces is a way to quickly access and create projects, it also 
“bookmarks” folders for quick access.  

First you need to subscribe to a client/matter: 

1) Click on Workspaces button to open at top. 

2) Right-Click the My Workspaces icon. 

3) Select the Profile Group where the Client and Matter are 
located 

4) Now enter the Client and Matter then Click OK. It will now 
show under the My Workspaces icon as a folder. 

5) You can now change the name if you would like – simply 
right-click the folder and choose rename workspace. 

Now when you click on this folder it will show you everything for 
that client and matter. If there are projects that have already been 
created they will automatically show under the folder in My 
Workspaces.  

To create a new project for that Client and Matter: 

1) Search for documents you want to include in your project. 

2) Drag them to the Top folder for the Client and Matter – Name the Project and Click OK. 

3) It will confirm that you want all selected or the one highlighted if you select more than 
one document. Click Continue. 

4) Now your new project is under the Client and Matter folder. To 
add more documents simply drag and drop to your 
project.  

These will stay here until you delete the project or unsubscribe 
to the Client and Matter. To unsubscribe simply right click on 
the Client/Matter folder and select unsubscribe. You can also 
create a project from here. 

Please note that if you create a project from here it will take the 
doc type from the first document in the client/matter folder. 
You will want to go edit the profile to the Project doc type.  
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Categories 
Categories are visual cues (a combination of keywords and/or symbols) that can be created, 
defined, and then assigned to files helping you to further organize files by providing additional 
information. You are able to assign more than one category to a file. There are 3 types of 
Categories available: Personal, Public or Folder. 
 

• Personal: Each user can create and use categories that are only viewable to that user.  
• Public: These are created by the Administrator and are available and viewable by all 

users. 
• Folder: These are created and available to all users, but are only available in that folder. 

 
Creating Categories  
First add Categories to your column header: 
By adding this column header to a Worldox file list it will allow you to view the icon(s) and text 
of any category assigned to the files listed.  
 

1. From the Worldox File List window, left-click on any gray area in the Column 
Heading bar to display the list of fields that can be added.  

2. Select Categories which will appear as a Column Heading.  

3. Resize the Categories column header as necessary. This is also a column heading that 
you can sort on.  

4. Note that category icons will always appear and text truncated to match space 
available.  

 
Create a Personal Category  

1. From the Worldox File List window, right-click under the 
Category column on a file and choose Add/Edit 
Categories. 

2. Click Add.  
3. Click the Personal tab. All Personal 

categories will display.  
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4. Choose an icon to best represent your category. Click More to view more available icons.  
 

5. In the New Category Name field, enter a name for the category.  

6. Click OK. The new Personal category will now be available and viewable to only the 
user that created and assigned the Personal category.  

 
Create a Folder Category (You must do a folder search (Direct Access or from Navigation 
Pane.) 
 

1. From the Worldox File Open window, right-click on the Category column on a file and 
choose Add/Edit Categories. Note the Category will be created in the folder of the 
file selected. 

 
2. Click Add.  

 
3. Click the Folder tab. All Folder categories will display.  
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4. Choose an icon to best represent your category. Click More to view more available icons.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. In the New Category Name field, enter a name for the category.  

6. Click OK. The new Folder category will now be available and viewable to only the user 
that created and assigned the Folder category. The Folder category will only be available 
for use in the Folder where the category was created.  

 
Assign Categories 
 
Assign a Category to a selected file using Add Category. 
 

1. From the Worldox File List window, select the file or files by selecting the ones you want 
to assign a Category to. Right-click under the Category column. Place your insertion 
point over Select Category.  
 
 
 
 
 
 

2. A list of available Categories will display (e.g., Personal, Public, Folder).  
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3. Place your insertion point over the Category you wish to make your selection from. A list 
of available Categories will be display. Select the desired Category. The icon and 
Category Name you assigned will appear under the Categories column header.  

 
 
Using Add/Edit Categories  
 

1. From the Worldox File List window, select the 
file you want to assign a Category to. Right-
click on the Category column. Place your 
insertion point over Add/Edit Categories. Or 
you access it from the File Menu or add to the 
Assign to Categories button to your toolbar.  

 
2. The Assign to Categories window will appear.  

 
3. Select the Category you want to assign by 

using checkbox and click Select. The icon and 
Category Name you assigned will appear 
under the Categories column header.  

4. The Clarification window will appear if you 
did not use the checkbox and just had an item highlighted. Click Yes to assign the 
Category if you forgot to check it and thus assign it.  

 
Note that using this dialog only assigns the Category to the file selected. To 
assign more than a single file see section below and use file tag in combination 
with the right-mouse click method.  
 
 
 

Assign Multiple Categories  
  
You can assign more than one Category to a file. Follow the steps described above. When 
multiple Categories are assigned to a file, they will appear in the following order when in the File 
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Open window: Personal, Folder, and then Public. Categories in subsets will appear in 
alphabetical order.  
 
Remove a Category 

1. From the Worldox File List window, select the file you 
want to assign a Category to. Right-click on the Category 
column.  

2. Choose Remove and select the Category you wish to 
remove.  

 
Delete a Category 

1. From the Worldox File List window, right-
click on the Category column.  

2. The Assign to Categories window will 
appear.  

 
3. Click on the tab (e.g., Personal) that contains 

the Category you want to remove from the 
list of available Categories.  

4. Select the Category and click Delete.  
 

5. Click Yes to delete the Category.  
 
 

If you delete a Category that is assigned to files, the Category will be deleted from 
the list of available Categories and also from the files that it has been assigned to.  
 

A great way to filter documents with a specific category is to use the TAGS Filter tab. See Page 
13 for more information about TAGS. 
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Worldox Keyboard Shortcuts 
 

 

File Management: 
Open ....................................................................... Enter 
Open With .......................................................... Ctrl + W 
Open, Place Cursor in Location Line ........................ F2 
Open, View File ........................................................... F9 
Open, Security .......................................................... F11 
Open, Sort Key ......................................................... F12 
Open, Toggle Comments on/off .................... Shift + F6 
Open, Place Cursor in the File Filter List ................. F3 
View, Move Next Occurrence of Text ........................ F3 
View, Move Previous Occurrence of Text .... Shift + F3 
Select, All ............................................................ Ctrl + A 
Deselect All ................................................ Alt + Ctrl + A 
Toggle Select on/off ............................................ Ctrl + I 
Move ............................................................................ F7 
Copy ............................................................................ F8 
Check-Out ........................................................... Alt + F8 
Check-In .............................................................. Alt + F9 
Security ..................................................................... F11 
Audit Trail ......................................................... Alt + F11 
Versions, Compare.................................... Alt + Ctrl + C 
Versions, New ......................................... Ctrl + Shift + V 
Delete ......................................................................... Del 
Email .................................................................. Ctrl + M 
Print List ............................................................. Ctrl + P 

Editing: 
Profile .................................................................. Ctrl + E 
Add to Favorites ............... Ctrl + NumPad Plus symbol 
Remove from Favorites ........... Ctrl + NumPad + minus 
symbol 
Copy Location to Clipboard .............................. Ctrl + C 
Preferences ....................................................... Ctrl + F1 
Starting List ...................................................... Ctrl + F2 

List: 
New ....................................................... Ctrl + Shift + Ins 
Direct Access ..................................................... Ctrl + O 
Selected Favorite Files ............................. Alt + Ctrl + F 
Relations .................................................... Alt + Ctrl + R 
Versions ..................................................... Alt + Ctrl + V 
Refresh ........................................................................ F5 
Previous File ....................................................... Ctrl + U 
Next File .............................................................. Ctrl + N 

Search: 
Find ............................................................. Ctrl + F 

Bookmarks: 
Add this List ............................................... Ctrl + D 
Create New ..................................... Ctrl + Shift + D 
Manage ....................................................... Ctrl + B 

Display: 
Bottom Tabs, Full List ............................... Ctrl + 1 
Comments .................................................. Ctrl + 2 
Profile ......................................................... Ctrl + 3 
Profile ......................................................... Ctrl + 3 
Viewer ......................................................... Ctrl + 4 
Relations .................................................... Ctrl + 5 
Project ........................................................ Ctrl + 6 
Sort ................................................................... F12 
Location Bar, Edit .............................................. F2 
Location Bar, Show/Hide ......................... Alt + F2 
File Filter Bar, Edit ................................. Shift + F2 
File Filter Bar, Show/Hide ........................ Alt + F3 
WorkList Tabs, Open Left of Current .... Ctrl + PgUp 
WorkList Tabs, Open Right of Current .. Ctrl + PgDn 
WorkList Tabs, Open First Tab ......... Ctrl + Shift + 1 
WorkList Tabs, Open Second Tab .... Ctrl + Shift + 2 
WorkList Tabs, Open Third Tab ........ Ctrl + Shift + 3 
WorkList Tabs, Open Fourth Tab ..... Ctrl + Shift + 4 
WorkList Tabs, Open Fifth Tab ......... Ctrl + Shift + 5 
WorkList Tabs, Open Sixth Tab ........ Ctrl + Shift + 6 
WorkList Tabs, Open Seventh Tab ... Ctrl + Shift + 7 
WorkList Tabs, Open Eight Tab ........ Ctrl + Shift + 8 
WorkList Tabs, Open Ninth Tab ........ Ctrl + Shift + 9 
WorkList Tabs, Last Tab .................... Ctrl + Shift + 0 
WorkList Tabs, Current Tab .......... Ctrl + Shift + F11 
WorkList Tabs, All Other Tab ........ Ctrl + Shift + F12 

Options: 
Audit Trail Query ..................................... Ctrl + F7 

Help: 
Access Help ....................................................... F1 
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